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Basics

930P supports One Seg terrestrial digital TV broadcasting.
One Seg
One Seg is a digital TV broadcasting service for mobile phones.
For more information, visit The Association for Promotion of Digital
Broadcasting Website:
[PC] http://www.dpa.or.jp/
[Handset] http://www.dpa.or.jp/1seg/k/
(Japanese only)

Features

Watch TV Programs Watch One Seg Digital TV on handset.
(#P.5-5)

View Data Broadcast | Access a variety of program-related

(C*P.5-7) information.

Record TV Programs Record program/capture still image while
(FP5-11) watching the program.

Set Timer Use Timer to view/record programs. You can easily
([C%P.5-13) set Timer by using Program Guide (C%P.5-7).

Mobile W-Speed

Frame rate of Digital TV images are automatically enhanced. Enjoy

smooth image flow (C%P.18-13).

® Mobile W-Speed is set to ON by default.

® When this function is set to ON, full effect of Image Quality may not
be achieved.

® Depending on broadcasting condition, full effect of this function may
not be achieved.

@ Disabled during ECO Mode (£%P.18-13) or AV output (£%P.10-13).

@ Disabled for playing back video clips recorded with Mobile W-Speed
set to ON.

Precautions

@ Digital TV is available only in Japan.

® Incoming calls/messages may affect TV image or audio quality while TV is
activated.

® Digital TV may be disabled if USIM Card is not installed or SoftBank
subscription is terminated.

@ SoftBank is not liable for damages from accidental loss/alteration of
handset/microSD Card information.
Saved data to handset (TV Links, Channel List, etc.) cannot be restored
after repairs or handset replacement. Back up important information.



Signal Reception Areas

TV signal reception may be poor in the following conditions:

@ Too far from or close to broadcasting stations.

@ Mountain areas or near tall buildings.

@ [n moving vehicles, underground, in tunnels, etc.

@ Near high-voltage wires, neon lights, wireless base stations, railroad
tracks or highways.

® Other areas where there is a significant number of signal obstructions
or areas where signal reception is blocked.

When Battery is Running Out
® When activating/watching/recording Digital TV programs with low
battery level, warning tone sounds.
@ \When battery runs low while programs are on or being recorded,
handset operates as follows:
- While Viewing
Warning tone sounds, and confirmation appears.
- While Recording
Response differs depending on Rec. When Low Battery
(C%P.18-13) setting.
Continue Recording ... Warning tone does not sound and
confirmation does not appear.
Stop Recording...\Warning tone sounds and confirmation appears.
® Watching TV during charging may shorten battery life.

@ |f recording ends due to low battery, recorded portion is automatically
saved.

Incoming Transmissions
TV pauses for incoming calls. Resume TV after call ends.
@ Incoming calls do not interfere with recording.

P eccccccccccccocccccccoe
@Use Other Functions while Viewing TV (C%P.5-8)
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Initial Setup

Set channels for your area.
@ Up to ten Channel Lists can be saved.

Main Menu p> TV p> Channel Setting p> Select Area

B 1 Selectaregion = Select a prefecture

AL [eubig
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2 YES

@ |f unable to set Channel List using Select Area, select Automatic
(C¥Below).

® 930P detects a change in reception area after moving to a different
area. Set Channel List for that area.

I Channel Settings

Setting Automatic Channel

Main Menu p> TV p> Channel Setting > Automatic
1 YES

2 After channel search, YES = Enter title

@ [f title is not entered, date (year/month/day/hour/minute) is
automatically saved as title.

Using Channel List

(From Jp Main Menu p> TV p> Channel List

M Set Channels

Select a Channel List

® Channel List is set, and available channels appear.
@ Select a channel to access the station.

I Delete Channel List
Highlight a Channel List, and press [¥7|][Menu] = Delete this = YES

I Delete Channels from Channel List
Highlight a Channel List, and press [=2][Detail] = Highlight a channel, and
press [x7][Menu] - Delete this - YES

M Edit Title
Highlight a Channel List, and press [¥7|[Menu] — Edit title - Edit

I Reassign a Remote Control Number (Keypad) to a
Channel

Highlight a Channel List, and press [=][Detail] = [%7][Menu] -

Remote control # = Select a channel = Select a new remote control

number — [=2|[Finish] = YES



Watching TV

® Set channels beforehand. (C%P.5-4)
@ Horizontal Open Position (C%P.1-6, P.1-7)

1 to activate

13chmmall

Record

2 Select a channel

Direct Channel
Access

-[9]

(*]J(Channel 10)
(0 J(Channel 11)
(#](Channel 12)

Previous/ =
Next Channel
Channel Search Press and hold fod

® To stop: [8][Cancel] /

3 ToendTV, - YES

@ Alternatively, Main Menu p> TV p» Watch TV

P ecccccccccccccccccccoe

@Display Digital TV Images on a TV (C%P.10-13) @Use Bluetooth® Device
for Wireless Playback (C%P.10-10)
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Item Description

©| Image -

®| Captions -

@ | Data Broadcast (%P5-7)

O Operation Mode & Data Broadcast Mode off
& Data Broadcast Mode on

©| ECO Mode (C%P.18-13)

@®| Channel (%P5-4)

@ | Signal Strength Level = = |
Strong Weak Out of range

© | Receiving Captions -

©| Volume -

®| Program Title -

® | Recording Video Recording EJREL] Timer Recording

®| Indicator/Caption Setting | Turn indicators/captions on or off




I Operations while Viewing TV I Program Guide

Volume Botilill Confirm and set timer to view/record TV programs.
Mute/Cancel Mute™'
Program Guide*? [=][EPG]

Main Menu p TV p> Program List

Press and hold =] @ Confirmation appears when using Program Guide for first time. Follow

Program Info iewer: onscreen instructions

® To return to Viewer: :

@[Disp.] @ Set timer to view/record selected program or check information.

° Altemz;tively in Landscape View (Normal See Program Guide Help menu for usage information.
Program Title Open Position)/Horizontal Open Position,

) I in Horizontal
pres =, or ) eso [ nHorenal | [ pata Broadcast (Japanese)

Indicator/ While Program Title appears: Access a variety of program-related information such as still

® Each key press toggles indicators (icons) and
captions on/off.

Information View*2 | While Program Title appears, [&][Change]

images and video clips.

® Data Broadcast is not available in Landscape View. Press [@] to switch to
Portrait View.

Caption View*?

Portrait/Landscape | ® Each key press toggles view. 1 Activate TV (Data Broadcast Mode off) =
View™! @ Close handset to return to Portrait View. appears.

® Not available in Horizontal Open Position [B] to select information.
Record Programs*' [@][Record] (¥P.5-11) ® To deactivate Data Broadcast Mode:

® To stop: [@][Stop]
Capture Still Images*'| Press and hold [@] (%P.5-12)

@ Viewing Data Broadcast information requires no fees: however,

Data Broadcast ad accessing websites will incur connection fees.
Mode On/Off*2 ° Eajhﬁl@y press toggles Data Broadcast Mode
on/off.

*1 Available when Data Broadcast Mode is off
*2 Available only in Portrait View
*3 Available only in Landscape View

AL [eubig u
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I Functions while Viewing TV

M Set Sound Effect

While TV is active, [%7][Menu] - Settings - Sound - Sound Effect »
Select an item (See below)

M Other Functions
While TV is active, follow the steps below.

Item

Operation/Description

Item

Operation/Description

Access
Internet via
Yahoo! Keitai

>
@ To return to viewer: While Yahoo! Keitai is active,

Remaster

Complement sound from earphone or Bluetooth® device
to bring close to original sound
> ON or OFF

Listening

Add listening effect to sound from earphone or
Bluetooth® device
> Select an item
- Surround: Reproduce natural and stereophonic
sound
- Natur 1 or Natur 2: Complement sound specific
to earphone to reproduce natural sound
- OFF: Turn off Listening setting

Equalizer

Change quality of sound from earphone or Bluetooth®
device
> Select an item
- Normal: Reproduce normal sound
- H. BASS1: Enhance low-pitched sound
- H. BASS2: Enhance low-pitched sound even more
- Voice: Make voice clear
- Train: Minimize sound leakage

Access > [Jmum) - Open Menu - Yahoo! Keitai -
Internet via PC Site Browser
PC Site ® Follow onscreen instructions
Browser
Make a Voice > []J(MULT) = Stand-by display = Enter a number -
Call/Video (7~ )/ e][Dial] (For Video Call, [=][V. Call])
Call ® Interrupt TV during call. After call, TV resumes.
@ Recording will not be interrupted.
Use > [J(muLT) = Stand-by display -
Messaging




M Functions Available while Viewing TV
While TV is active, [¥7][Menu] = Select an item (See below)

Item Operation/Description
Channel View channel details. Select a channel to watch that
info*' station

Program info

View current program information

Channel List*'

View channel list (£%P.5-4)

Channel Set channels for your area (C%P.5-4)
Setting™!

Add to ch. Add current station to Channel List
list*! >YES

® Assign current station to lowest available number key.

Program list™'

View program list

Switch Switch view (switch image size/image off)
display™’ > Select an item
SwitchTV/  In Portrait View, toggle Data Broadcast Mode on/off
data BC*' ([C*P.5-7)
Icons*? Set Guide Display in Landscape View
> ON or OFF
Compose Create S! Mail while listening to sound (Z%From Step 2
S! Mail on P.13-4)

Item Operation/Description
Settings > Select an item
- Brightness: Set Back Light brightness
- Mobile W-Speed**: Enhance frame rate of TV
images automatically
- Image Quality*?: Select an image quality
- LCD Al Activate image compensation according to
Back Light
- Sound — Sound Effect*? (7P.5-8)
- Sound - Main/sub sound: Set main/sub sound
- Sound — Switch audio data: Available only
when multiple audio data are supported
- Sound - TV Sound W/ Closed**: Set whether to
keep speaker on when closing 930P while viewing TV
- ECO Mode*?*: Set power saving mode (C%P.18-13)
Data > Select an item

Broadcasting*!

- Reload contents: Reload page (Data Broadcast link)

- Certificate: View owner, author, validity period and
serial number of certificate used in SSL communication

- Images™*?*: Show/hide images on Data Broadcast
sites

- Sound Effect**: Turn on/off sounds from Data
Broadcast/sites

- Reset Settings™*: Show confirmation on Data
Broadcast

W/ NextPage 4

AL [eubig
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Item Operation/Description

Back to data End Data Broadcast site and return to Data Broadcast
BC*' window

Tune service*' Select a program when multiple programs are available
from the same broadcasting company
> Select a station or its affiliate

TV Link*' Show TV Link details

AV output View a Digital TV image on a TV set or other devices

(¥P.10-13)

*1 Available only in Portrait View
*2 Available from User Settings even while TV is not active (C3P.18-13).

TV Links (Japanese)
I Saving TV Links
@ Following functions are not available in Landscape View.

1 Switch Data Broadcast Mode on = Select a link

7 YES

I Opening TV Links
Main Menu » TV P> TV Link
1 Select a TV Link

@ |f confirmation appears asking whether to connect to Internet,
select YES.

® [fTV Link is expired, confirmation appears asking whether to delete
link.



I Functions Available in TV Link List

Main Menu p TV p> TV Link
1 [Menu] — Select an item (See below)

Item

Operation/Description

Display detail Show TV Link title, URL, summary, content type, expiration

date
No. of TVIink  Show number of saved TV Links
Delete this > VYES
Delete > Check TV Links to delete = [=][Finish] - YES
selected
Delete all > Enter Phone Password = YES

Recording/Playing Programs
I Recording Current Program

Save programs as videos or still images.
Recordings are saved to microSD Card.
® microSD Card: C5P.9-15

@ Save up to 2GB of data at a time.

Recording Time (total)* | Approx. 740 minutes

Savable Files 99 files

* Average recordable time per 2GB of data
@ Recording is unavailable when signal strength drops to =3

1 Activate TV (Data Broadcast Mode off) = E][Record]

[BIREC] appears, and recording starts.

2 [@][Stop] to stop recording

Program is saved to microSD Card.

_Note |
@ In the following cases, recording ends and recorded portion is
automatically saved:
- File size is over 2GB
- microSD Card memory is full
@ Recorded files are not saved to handset.
@ Do not remove microSD Card while recording.
@ Recording continues even if signal strength level is Z4 ; however,
images and audio are not saved.
@ Data Broadcast information cannot be recorded.

@ Recording is disabled during AV output.
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I Capturing Screenshots

Captured screenshots are saved to handset.

@ This feature is unavailable when signal strength is =3 or Data Broadcast
Mode is on.

1 Activate TV (Data Broadcast Mode off), and press and

hold [aa]

=
Q
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@ Captions cannot be captured.
® Capturing is disabled during AV output.

I Playing Recorded Programs

Main Menu b Data Folder > TV > Video

Select a file & micros)  1/2
[162009/02/02 10:16
Playback starts. E1$52009/02/02 10:13

E1$2009/02/02 10:11
E1652009/02/02 10:11
E$2009/02/02 10:11
[352009/02/02 10:11

™

Example: Video
Folder

p) to stop playback
5-12

Playback Operations
Volume petioli
Mute/Cancel Mute | [x|[ IESE/ BETH ]|
Play Previous File @ Play back from beginning when playback time
is over ten seconds.
Play Next File [of
Pause/Resume [o][Im/ICH ]
Play Frame by Pause playback = [=|[Frame]
Frame ® Play back frame by frame.
Skip Rewind
(30 Seconds)*! Press and hold o /(%)
Skip Forward
(30 Seconds)*! Press and hold [ of /(%]
Toggle Playback
speed 2 /]
[@][Disp.]
View Title @ In Landscape View, indicator/caption setting
display appears.
Display title - [&][Change]
Toggle Caption @ In Landscape View, each key press toggles
indicators (icons) and captions on/off.
Portrait/Landscape
View*2*3 ® Each key press switches view.

*1 Operation is unavailable if file is under 30 seconds long.
*2 Close handset to return to Portrait View.
*3 Disabled in Horizontal Open Position




IViewing Captured Screenshots

Main Menu p- Data Folder p> TV p> Image

1 Selectan image

I Timer

@ Set up to 100 timer entries to watch or record programs.

Main Menu p> TV

1 Timer Watching or Timer Recording B
p) [New] — Select an item (See below) g
=
Item Operation/Description n_—’|
Start date Set date and time to start viewing/recording a program <
setting > Select an item
End date - Enter date — Enter a date
setting*’ - Choose date — Select a date
Channel > Select a channel
Edit title > Enter a program name
Repeat > Select a repetition = For Select day, select a day (days)
- [=2][Finish]
Alarm*? > ON or ON/Set time — For ON/Set time, select an
alarm time
Clock Alarm > Select an alarm type = Select a folder = Select an
Tone*? alarm
Alarms™' > ON or OFF
Volume >[Z] to adjust volume
® For Timer Recording, Escalating Tone cannot be set.
Activate TV~ > ON or OFF
w/ alarm*?2 ® When ON is set, Digital TV activates from alarm

notification window.

W/ Next Page LR}



=
«Q

-
L
—
<

5-14

Item Operation/Description

Priority*! Set handset response when Timer Recording starts

> Recording or Operation

® When Recording is set, active function suspends/
ends, and recording starts.

® \When Operation is set, confirmation appears.
To suspend/end active function, select YES and [@] to
start recording.

Other Timer Operations
Main Menu p TV

1 Timer Watching or Timer Recording

2 [Menu] — Select an item (See below)

T : Item Operation/Description
1 Timer Recording only -
o A New Set a timer entry to watch/record a program (C%P.5-13)
2 Timer Watching only . - -
Edit Edit entry details (C%P.5-13)
[s2|[Finish] = For Timer Recording, select YES or | Sort Sort timer entries
YES (confirm once) . > Select an order
Delete this > VYES
[ Note | Delete past  Timer entries with start/end time set prior to current date/
® Select timer entries to check details; [&2][Edit] to edit details. time are deleted
® Timer Recording does not start if Internet and two other functions are >YES
active simultaneously. Delete > Check timer entries to delete - [=|[Finish] = YES
® Alarm does not sound for Timer Watching/Timer Recording in following selected
functions. For Timer Recording, complete followings (in parentheses) Delete all > Enter Phone Password = YES
one minute before timer starts; otherwise, recording does not start. Memory Show memory status
- While handset is off (Turn on handset) Status
- While Privacy Key Lock or Personal Data Lock is active (Cancel Lock) [Timer

- During data transfer (Complete transfer)
- During Infrared transmission, IC transmission or Bluetooth®
transmission (Complete transmission)

- During software update (Complete update)

Recording only]

Checking Timer Recording Results
Main Menu p TV

1 Recording Result - Select a result
® Details appear.
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